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VISI MISI 

PROGRAM STUDI S-1 ADMINISTRASI RUMAH SAKIT 

SEKOLAH TINGGI ILMU KESEHATAN YOGYAKARTA 

 

VISI 

Mampu menghasilkan Sarjana Administrasi Rumah Sakit yang profesional, unggul dalam 

bidang Administrasi Tata Kelola Perumahsakitan dan berdaya saing di tingkat 

internasional dengan dijiwai karakter yang berbudaya pada tahun 2036. 

 

MISI 

1. Menyelenggarakan pendidikan yang berkualitas sehingga mampu menghasilkan 

Sarjana Administrasi Rumah Sakit yang profesional, unggul dan berdaya saing di 

tingkat internasional, dengan dijiwai karakter berbudaya. 

2. Mengembangkan ilmu pengetahuan yang berdaya guna melalui kegiatan penelitian 

bidang Administrasi Tata Kelola Perumahsakitan yang mampu bersaing di tingkat 

internasional. 

3. Menyelenggarakan kegiatan pengabdian kepada masyarakat bidang administrasi tata 

kelola perumahsakitan dengan memperhatikan budaya yang ada di masyarakat 

setempat. 

4. Menyelenggarakan tata kelola program studi sarjana administrasi rumah sakit yang 

sehat dan mampu bersaing di tingkat internasional. 
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Puji syukur kami panjatkan kepada Tuhan Yang Maha Esa, karena atas rahmat dan 

karunia-Nya Modul Praktikum Biostatistik Kesehatan Program Studi S-1  Administrasi 

Rumah Sakit Sekolah Tinggi Ilmu Kesehatan Yogyakarta ini dapat kami selesaikan. 

Modul ini disusun sebagai salah satu media pembelajaran mata kuliah Biostatistik 

Kesehatan. 

Penyusunan Modul Praktikum ini bertujuan untuk membantu mahasiswa dalam 

mencapai kompetensi yang telah ditetapkan, sehingga setelah menempuh mata kuliah 

praktik ini mahasiswa diharapkan memiliki pengetahuan dan keterampilan mengenai 

aplikasi dari Biostatistik Kesehatan. 

Penyusunan modul ini mendapat dukungan dari berbagai pihak. Oleh karena itu 

pada kesempatan ini kami mengucapkan terima kasih sebesar-besarnya kepada semua 

pihak yang telah membantu dan memberikan dukungan. Semoga segala bantuan dan 

kebaikan menjadi amal sholeh yang akan mendapat balasan yang lebih baik dari Tuhan 

Yang Maha Esa. 

Kami menyadari bahwa Modul Praktikum Biostatistik Kesehatan ini masih belum 

sempurna. Demi sempurnanya Modul Praktikum ini, kami mengharapkan masukan, saran 

dan kritik yang membangun dari berbagai pihak demi perbaikan Modul Praktikum 

Biostatistik Kesehatan ini.  
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MODUL PRAKTIKUM  

BIOSTATISTIK KESEHATAN 

 

A. Deskripsi Mata Kuliah 

Mata kuliah biostatistik kesehatan ini ditempuh oleh mahasiswa Program 

Studi S-1 Administrasi Rumah Sakit Semester IV dengan beban 2 SKS (1 SKS 

Teori, 1 SKS Praktikum). Dengan mengikuti praktikum ini, mahasiswa akan akan 

mendapatkan pengetahuan, pemahaman, dan keterampilan dalam menerapkan 

biostatistik kesehatan dalam rangka penyusunan penelitian. Untuk mencapai 

kompetensi pada akhir pembelajaran, maka ada beberapa proses pembelajaran yang 

akan ditempuh, antara lain: perkuliahan di kelas, pembelajaran mandiri, praktikum 

keterampilan, dan diskusi kelompok dengan prinsip pembelajaran aktif.  

Modul praktikum mata kuliah biostatistik kesehatan merupakan pedoman 

praktikum yang harus dipelajari dan dilaksanakan oleh mahasiswa Program Studi 

S-1 Administrasi Rumah Sakit STIKes Yogyakarta. 

 

B. Capaian Pembelajaran 

Mata kuliah ini memberikan kesempatan kepada mahasiswa mengenai 

konsep ilmu statistika bidang kesehatan yang terdiri atas konsep biostatistik serta 

menganalisa data dalam penulisan ilmiah. Fokus bahasan dalam mata kuliah ini 

meliputi  konsep biostatistik, dan penelitian, konsep sampling, konsep hipotesis, 

perhitungan sampel, konsep uji parametrik dan nonparametrik. Capaian 

pembelajaran praktikum mata kuliah ini yaitu: 

1. Mahasiswa mampu mendalami menu-menu di aplikasi SPSS. 

2. Mahasiswa mampu melakukan pengolahan data secara deskriptif, bivariat dan 

multivariat  

3. Mahasiswa mampu melakukan pengolahan data secara Uji beda 2 mean 

independen dan dependen (nonparametrik)  

4. Mahasiswa mampu melakukan pengolahan data secara Uji rerata  >2 mean 

(parametrik) 
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5. Mahasiswa mampu melakukan pengolahan data secara Uji 

korelasi/asosiasi/hubungan (parametrik) 

6. Mahasiswa mampu melakukan pengolahan data secara Uji 

korelasi/asosiasi/hubungan (nonparametrik) 

7. Mahasiswa mampu melakukan pengolahan data secara Uji regresi logistik 

Kesehatan 

C. Rancangan Pembelajaran 

Untuk mencapai kompetensi pada akhir pembelajaran, maka ada beberapa 

proses pembelajaran yang akan ditempuh, antara lain praktikum keterampilan, 

praktikum dikelas, perkuliahan teori di kelas, pembelajaran mandiri, praktikum di 

kelas dan diskusi dengan prinsip pembelajaran aktif. Beban SKS Praktik = 1 SKS 

x 170 menit x 14 minggu = 2.380 menit = 14 TM. Artinya 1 SKS ekuivalen dengan 

14 kali praktikum tatap muka. 

1. Jenis Keterampilan 

a. Menginstall dan mempelajari menu aplikasi SPSS 

b. Melakukan pengolahan data secara deskriptif, uji validitas, uji reliabilitas  

c. Melakukan pengolahan data secara uji beda 2 mean independen dan 

dependen (nonparametrik)  

d. Melakukan pengolahan data secara uji beda  >2 mean (parametrik) 

e. Melakukan pengolahan data uji korelasi /hubungan (parametrik) 

f. Melakukan pengolahan data uji korelasi/ /hubungan (nonparametrik) 

g. Melakukan pengolahan data secara uji regresi logistik kesehatan 

2. Metode Pembelajaran Praktikum 

Metode pembelajaran praktikum biostatistik kesehatan dilaksanakan secara 

tatap muka dengan menerapkan prinsip pembelajaran aktif dengan 

pendampingan dosen. 

D. Jadwal Pelaksanaan 

1. Waktu 

Perkuliahan dilaksanakan tanggal 29 Februari 2024 sampai dengan 20 Juni 

2024.  
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Praktikum biostatistik kesehatan dilaksanakan pada tanggal 3 April sampai 

dengan 26 Juni 2024.  

2. Tempat 

Tempat pelaksanaan praktikum biostatistik kesehatan dilaksanakan di RB 2.3 

Sekolah Tinggi Ilmu Kesehatan Yogyakarta. 

 

E. Tata Tertib dan Sanksi 

1. Tata Tertib Mahasiswa 

a. Mahasiswa menggunakan seragam sesuai ketentuan.  

b. Mahasiswa hadir sebelum jam praktikum dimulai.  

c. Mahasiswa diharapkan membawa alat tulis. 

d. Mahasiswa membawa handphone dan laptop untuk mencari referensi. 

e. Mahasiswa mengikuti kegiatan praktikum sesuai dengan ketentuan. 

2. Tata Tertib Pembimbing 

a. Pembimbing wajib memberikan pengarahan kepada mahasiswa sebelum 

praktikum dimulai. 

b. Pembimbing wajib mendampingi pada setiap praktikum. 

c. Pembimbing wajib melakukan konsultasi laporan setiap praktik yang 

dilakukan mahasiswa. 

d. Pembimbing mengoreksi dan menilai hasil laporan praktikum. 

e. Pembimbing melakukan penilaian presentasi laporan praktikum. 

3. Sanksi 

Bagi mahasiswa yang melanggar tata tertib akan dikenakan sanksi berupa tidak 

diijinkan untuk mengikuti praktikum tersebut dan selanjutnya. 

 

F. Pembimbing 

Tutik Wahyuningsih, S.KM., M.PH 
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G. Penilaian 

Hasil penilaian, baik dinyatakan secara absolut maupun secara huruf 

menggambarkan mutu, didasarkan pada perolehan nilai: 

Komponen  Presentase 

Teori UTS= 30% 60% 

UAS = 30% 

Praktikum  20% 

Penugasan  20% 

 

Standar range Penilaian dari STIKes Yogyakarta 

Angka Huruf Keterangan 

80 - 100 A Sangat Baik 

65 - 79 B Baik 

55 - 64 C Cukup 

40 - 54 D Kurang  

< 39 E Gagal 

 

H. Evaluasi 

Bentuk evaluasi praktikum biostatistik kesehatan adalah sebagai berikut:  

1. Penilaian praktikum 

2. Laporan praktikum dalam bentuk makalah. 

3. Laporan praktikum dalam bentuk kliping. 

 

 

 

 

 

 

 

 



 Modul Praktikum Biostatistik Kesehatan  5 
 
 
 

 

 
 

KEGIATAN PRAKTIKUM 1 
PENDALAMAN APLIKASI SPSS 

 

A. Tujuan Pembelajaran Praktikum 

Setelah mempelajari kegiatan praktikum 1 ini, diharapkan mahasiswa mampu 

mengoperasikan aplikasi SPSS dengan baik. 

 

B. Materi 

Statistical Package for Social Science (SPSS) merupakan salah satu program 

yang diperuntukkan dalam analisis data. Pengoperasian SPSS yang user friendly 

menjadikan banyak dipilih oleh dosen, mahasiswa maupun peneliti untuk 

melakukan analisis data.   

  
Jika SPSS terdapat dua “sheet”, yaitu data view dan variable view yang 

masing-masing memiliki peruntukan yang berbeda.  

1. Data View 

Data view digunakan untuk memasukkan data-data yang diperoleh dari kegiatan 

penelitian.  



 Modul Praktikum Biostatistik Kesehatan  6 
 
 
 

2. Variable View  

Variable view digunakan untuk menguraikan karakteristik variabel penelitian, 

yaitu memberi nama, label, koding, skala data.  

 
 

Langkah pertama yang dilakukan adalah melakukan  
identifikasi karakteristik variabel penelitian yang dilakukan melalui jendela 
Variable View 

 
C. Aktivitas Praktikum 

1. Buka program SPSS. 
2. Aktifkan variable view, identifikasi tampilan SPSS dan catat kegunaannya. 
3. Identifikasi menu program di aplikasi SPSS. 

Entri Data 

Entri Variabel 

Margi
n 

Skala Data 

Kodin
g 

 
Beri Nama Variabel 

 
Menjelaskan Tipe Data 

Mengatur lebar kolom 

Mengatur digit di blg koma 
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KEGIATAN PRAKTIKUM 2 
PENGOLAHAN DATA SECARA 

DESKRIPTIF, UJI VALIDITAS, DAN 
UJI RELIABILITAS 

 

 

A. Tujuan Pembelajaran Praktikum 

Setelah mempelajari kegiatan praktikum 2 ini, diharapkan mahasiswa 

mampu melakukan pengolahan data secara deskriptif, uji validitas dan uji 

reliabilitas dengan baik. 

 

B. Materi 

1. Analisis Deskriptif  

Langkah-langkah praktik dalam analisis deskriptif: 

a. Dari Jendela Data Editor SPSS 
Klik Menu File → Open → Data. 

b. Pilih File Data yang akan dianalisis. 
c. Klik Menu File → Save As 
d. Lakukan Pengolahan Statistik Deskriptif  

Analyze => Descriptive Statistics => Frequencies => Mean, Median, 
and Mode => Continue => Ok  

 
2. Uji validitas  

Uji validitas menggunakan SPSS berfungsi melihat suatu alat ukur valid 

(sahih) / tidak. Alat ukur merupakan pertanyaan yang ada di kuesioner. Kuesioner 

dikatakan valid jika pertanyaannya dapat mengungkapkan sesuatu yang diukur 

oleh kuesioner. Dalam uji pengukuran validitas terdapat dua macam cara, yaitu 

pertama, mengorelasikan antar skor butir pertanyaan (item) dengan total item. 
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Kedua, mengorelasikan antar masing-masing skor indikator item dengan total skor 

konstruk. Pengujian validitas yang mengorelasikan antar masing-masing skor item 

indikator dengan total skor konstruk. Tingkat signifikansi yang digunakan yaitu 

0,05. Kriteria pengujian validitasnya sebagai berikut:  

H0 diterima apabila r hitung > r tabel, (alat ukur yang digunakan valid atau sahih)  
H0 ditolak apabila r statistik ≤ r tabel. (alat ukur yang digunakan tidak valid atau 

sahih) Sedangkan cara untuk menentukan besar nilai R tabel adalah sebagai 

berikut: R tabel = df (N-2), tingkat signifikansi uji dua arah. Misalnya, R 

tabel = df (13-2, 0,05). Lihat table R Untuk mendapatkan nilai R table. 

Berikut ini langkah melakukan uji validitas.  

a. Buka aplikasi SPSS. Silakan atur format yang ada di Variable View.  

b. Selanjutnya, cari nilai total dari variabel X. Caranya klik menu 

Transform> Compute Variable. Maka akan muncul kotak dialog. 

c. Isikan kolom Target Variable dan Numeric Expression lalu klik OK.  

d. Lihat 'Data View' ada penambahan kolom baru yaitu kolom X1total  

e. Selanjutnya, mencari nilai R statistik atau R hitung. Caranya klik 

Analyze> Correlate> Bivariate. Maka akan muncul kotak dialog berikut.  

 
f. Lalu, pindahkan semua item variabel ke kotak Variables. Pada 

Correlation Coefficients beri centang pada Pearson. Di bawahnya 

centang Two-Tailed dan Flag Significant Correlation. Lalu, klik OK.  

- Correlation is significant at the 0.05 level (2-tailed).  

- Correlation is significant at the 0.01 level (2-tailed).  

g. Interpretasi Uji Validitas  

- Cari nilai R tabel terlebih dahulu. Sesuai ketentuan dari df (N-2, 

0,05). N adalah jumlah data yang diuji. Jadi, untuk mencari nilai R 

tabel menggunakan ketentuan: R tabel = df (13-2, 0,05) = 0,5529.  

- Bandingkan nilai R tabel dan R hitung sesuai kriteria pengujian. 

X1.1 = 0,781 > 0,552, maka H0 diterima, artinya alat ukur yang 
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digunakan valid atau sahih. X1.2 = 0,764 > 0,552, maka H0 diterima, 

artinya alat ukur yang digunakan valid atau sahih dan seterusnya.  

- Selain menggunakan R hitung, lihat tingkat signifikansinya. Apabila 

tingkat signifikansi item < 0,05, alat ukur yang digunakan valid. 

3. Uji Reliabilitas 

Reliabilitas adalah indeks yang menunjukkan sejauh mana suatu alat 

pengukur dapat dipercaya atau diandalkan. Uji reliabilitas untuk 

mengetahui konsistensi alat ukur, apakah alat ukur konsisten jika 

pengukuran tersebut diulang. Alat ukur dikatakan reliabel jika menunjukkan 

hasil yang sama meskipun dilakukan pengukuran berulang kali. Pada 

umumnya, sebelum uji reliabilitas data, dilakukan terlebih dahulu uji 

validitas data karena data yang akan diukur harus valid. Namun, jika data 

yang diukur tidak valid, tidak perlu dilakukan uji reliabilitas data. Jenis Uji 

reliabilitas data untuk menguji reliabilitas data terdapat beberapa metode 

sebagai berikut: tes ulang, formula flanagan, cronbach’s alpha, formula kr 

(kuder-richardson) dan anova hoyt. terdapat banyak metode uji reliabilitas, 

untuk data penelitian dan kuesioner digunakan metode Cronbach’s Alpha.  

a. Uji Reliabilitas Metode Cronbach’s Alpha 

Menurut Arikunto (2010), Cronbach’s Alpha digunakan untuk mencari 

reliabilitas instrumen yang skornya bukan 1 atau 0. Perhitungan 

menggunakan rumus Cronbach’s Alpha diterima apabila perhitungan r 

hitung > r tabel 5%. Langkah perhitungan uji reliabilitas data metode 

Cronbach’s Alpha dengan SPSS :  

1) Pastikan program SPSS sudah terinstal, buka program SPSS.  

2) Siapkan dan entry data yang diperlukan (contoh: data kuesioner) ke 

variable view dan data view.  

3) Kemudian, klik Analyze > Scale > Reliability Analysis...  

4) Muncul Reliability Analysis. Pindah seluruh data variabel berupa 

skala ke kolom Items (ke sebelah kanan) dan pilih model Alpha.  

5) Setelah itu, klik Statistics...,  

6) Muncul tampilan Reliability Analysis: Statistics, kemudian pada 

bagian Descriptive For centang Scale dan Scale if item deleted.  
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7) Klik Continue. Selanjutnya, klik OK dan lihat hasil pada Output.  

8) Interpretasi Hasil Uji Reliabilitas Metode Cronbach’s Alpha.  

9) Setelah perhitungan data, kemudian hasil perhitungan uji reliabilitas 

akan muncul pada Output. Pada Output hasil perhitungan data 

berupa tabel, yaitu Case Processing Summary, Reliability Statistics, 

Item- Total Statistics, dan Scale Statistics.  

Table Output Hasil Perhitungan Case Processing Summary  

  
Pada tabel diatas menyatakan bahwa jumlah responden ada 10 dan 

persentase menunjukkan 100%. Hal tersebut menandakan bahwa 10 

responden tersebut valid dan tidak ada responden yang masuk ke 

kategori Exculded. Kemudian, untuk mengetahui hasil perhitungan 

data dapat dipercaya dan konsisten / reliabel, dapat diperhatikan 

pada tabel Reliability Statistics.  

Tabel Reliability Statistic 

   
Melalui metode Cronbach’s Alpha (r hitung) hasil perhitungan uji 

reliabilitas dapat dilihat pada kolom Cronbach’s Alpha, yaitu 0.688 

dengan N of Items menunjukkan bahwa jumlah dari items atau 

jumlah pertanyaan yang diinput pada variable view adalah 5. 

Artinya, hasil Cronbach’s Alpha untuk 5 data dari items atau 5 

pertanyaan, yaitu 0.688. Untuk mengetahui data dapat dipercaya / 

tidak, apabila perhitungan r hitung > r tabel 5%, di mana r hitung 

dilihat dari tabel hasil perhitungan yang didapatkan pada SPSS.  

C. Aktivitas Praktikum 

1. Lakukan pengolahan data secara deskriptif. 

2. Lakukan uji validitas. 

3. Lakukan uji reliabilitas.  
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A. Tujuan Pembelajaran Praktikum 

Setelah mempelajari kegiatan praktikum 3 ini, diharapkan mahasiswa 

mampu melakukan pengolahan data dengan uji beda 2 mean independen dan 

dependen sesuai langkah yang benar. 

 

B. Materi 

T test independent/tidak berpasangan, paired T test dan nonparametrik 

digunakan untuk uji beda rerata dua mean. Perlu dipahami bahwa syarat untuk 

dapat menggunakan uji T baik uji T berpasangan dan uji T tidak berpasangan 

memerlukan sebaran data pada variabel dependen wajib normal dan nilai 

varians bisa tidak sama. Apabila persyaratan tersebut tidak memenuhi, 

sebagai alternatifnya menggunakan uji nonparametrik. Untuk uji T tidak 

berpasangan, maka nonparametriknya adalah uji Man Whitney, sedangkan 

untuk uji T berpasangan, maka nonparametriknya adalah uji T Wilcoxon.  

Cara membedakan apakah menggunakan uji T berpasangan atau uji T 

tidak berpasangan, lihatlah pada jenis sampel yang digunakan. Apabila 

sampel yang digunakan adalah menghasilkan data berpasangan, gunakan uji 

T berpasangan/paired T test. Jika sampel yang digunakan dalam penelitian 

menghasilkan data tidak berpasangan, gunakan uji T tidak berpasangan. 

Contoh sampel berpasangan: peneliti ingin mengetahui antara tingkat nyeri 

setelah kemoterapi pada pasien kanker sebelum dan sesudah diberi intervensi. 

Sedangkan contoh sampel tidak berpasangan: peneliti ingin membandingkan 

kadar tekanan darah sistolik pada pasien yang menggunakan alat kontrasepsi 

hormonal dan dibandingkan dengan kadar tekanan darah pasien yang tidak 

menggunakan alat kontrasepsi non hormonal. 

 

 

 

KEGIATAN PRAKTIKUM 3  
UJI BEDA 2 MEAN INDEPENDEN 

DAN DEPENDEN 
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Gambar skema uji 

Uji sebaran data dari variabel yang akan dianalisis terlebih dahulu 

sebelum melakukan uji T tidak berpasangan. Uji Levene digunakan untuk 

mengetahui nilai varians dari variabel yang akan diuji tersebut. Dikatakan 

varian sama apabila nilai sig pada uji Levene ≥ nilai alpha (α), maka 

disimpulkan varians sama. Contoh: nilai sig pada uji Levene adalah 0,06, kita 

bandingkan nilai alpha (α) sebesar 5%, maka disimpulkan bahwa varians 

sama. Begitu juga sebaliknya, apabila nilai sig pada uji Levene ≤ nilai alpha 

(α), maka disimpulkan varians tidak sama. Persyaratan yang digunakan untuk 

bisa menguji dengan uji T tidak berpasangan adalah variabel dependen pada 

sebuah penelitian terdistribusi normal pada kedua kelompok, variabel 

dependen tidak menunjukkan outlier penting dalam grup mana pun, varians 

grup sama atau tidak sama (menggunakan uji Levene untuk memeriksa 

homogenitas). Langkah-langkah pengujian uji T tidak berpasangan gunakan 

File: data tidak berpasangan  Analyze > Compare Means > Independent-

Samples T Test; masukkan data kadar HB dalam test variabel => klik di 

Grouping Variabel: klik Define Groups (ANC kodenya 1= ANC; 2= Tidak 

ANC). Masukkan ANC, type 1 di group 1 dan Type 2 di Group 2 => klik 

Continue => Klik OK.  
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Interpretasi Hasil Uji T Tidak Berpasangan  

Dari uji Levene terlihat bahwa nilai p value (sig) = 0.99, kita bandingkan 

dengan nilai alpha 0.05 (0,99> 0,05) disimpulkan bahwa varian kadar Hb 

adalah sama (equal). Jadi, untuk selanjutnya pembacaan menggunakan varian 

yang equal. Cara menarik kesimpulan dari analisis menggunakan uji T tidak 

berpasangan adalah sebagai berikut: nilai sig (pada hasil output SPSS) 

dibandingkan dengan nilai α (misal α = 5%~~0,05). Jika nilai sig ≤ α maka 

kita menyimpulkan Ha. Begitu juga sebaliknya, apabila nilai sig > α maka 

kita dapat menyimpulkan Ho. Sekarang dilihat dari nilai sig di output SPSS 

pada kasus kali ini. Dilihat nilai sig (p value pada uji t) = 0,846; perbedaan 

mean= -0,039; dan CI (confidence interval) = - 0,443 sampai dengan 0,364. 

Kita bandingkan nilai p value pada uji t independent (0,846) > dengan α (0,05). 

Jadi, dapat disimpulkan bahwa tidak ada perbedaan kadar Hb antara 

kelompok yang melakukan ANC dan tidak ANC.  

C. Aktivitas Praktikum 

1. Mahasiswa melakukan praktik pengolahan data dengan uji beda 2 mean 

independen dan dependen. 

2. Mahasiswa memahami dan mencatat langkah-langkah uji man whitney 

3. Mahasiswa praktik melalui aplikasi SPSS melakukan pengolahan data 

dengan uji man whitney. 

4. Mahasiswa memahami dan mencatat langkah-langkah uji wilcoxon. 

5. Mahasiswa praktik melalui aplikasi SPSS melakukan pengolahan data 

dengan uji wilcoxon. 
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A. Tujuan Pembelajaran Praktikum 

Setelah mempelajari kegiatan praktikum 4 ini, diharapkan mahasiswa 

mampu melakukan pengolahan data dengan uji rerata lebih dari dua mean 

sesuai dengan langkah yang benar. 

 

B. Materi  

Anova adalah kepanjangan dari Analysis of Variance atau dikenal juga 

dengan istilah analisis ragam. Anova merupakan salah satu jenis analisis data 

yang sering digunakan dalam penelitian eksperimen atau percobaan dan 

termasuk salah satu jenis analisis parametrik. Uji Anova dikembangkan oleh 

R.A Fisher untuk membandingkan rata-rata (rerata) lebih dua kelompok 

sehingga dapat menarik kesimpulan hubungan-hubungan di antara mereka. 

Anova bisa juga dikatakan sebagai kelanjutan uji dari uji T khusus untuk 

membandingkan rerata lebih dari dua kelompok (Chernick and Robert, 2005). 

Uji Anova ini ada beberapa jenis tergantung dari faktor atau kelompok 

pada variabel independen.  

1. Anova Satu Arah (Anova One Way)  

Uji Anova satu arah merupakan salah satu jenis uji Anova yang paling 

sederhana karenakan faktor pada variabel independen bersifat sederhana 

(satu faktor) yang menimbulkan variasi. Contoh analisis data menggunakan 

uji Anova satu arah adalah peneliti ingin membandingkan efek dari 

pemberian obat A dengan dosis yang berbeda terhadap penurunan tingkat 

nyeri pada binatang percobaan.  

2. Anova Dua Arah (Two Way Anova)  

Uji Anova dua arah adalah uji Anova yang menggunakan dua (2) faktor 

sebagai sumber variasi yang berdampak pada variabel dependen. Contoh: 

 

 
KEGIATAN PRAKTIKUM 4 
UJI RERATA LEBIH DARI  

DUA (>2) MEAN  
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peneliti akan melihat penurunan tingkat nyeri pada binatang percobaan, 

tidak hanya memberi dosis yang berbeda, tetapi juga melihat frekuensinya.  

3. Anova Banyak Arah (Manova) 

Uji Manova adalah pengembangan lebih lanjut dari uji Anova yang mana 

faktor yang diamati banyak kriteria. Asumsi Dasar Uji Anova pertama yang 

harus dipenuhi agar dapat menggunakan uji Anova adalah sebaran data pada 

variabel dependen penelitian harus berdistribusi normal. Asumsi kedua 

adalah varian dalam populasinya harus sama. Kesamaan varian ini 

berhubungan dengan uji F yang nanti akan dilakukan. Apabila varian dari 

populasi penelitian tidak sama, uji Anova tidak dapat dilakukan. Untuk 

menguji sebaran data (normalitas data pada variabel dependen) 

menggunakan uji Shapiro Wilk atau Kolmogorov Smirnov. Dikatakan 

sebaran data berdistribusi normal apabila nilai sig atau p value pada uji 

Shapiro Wilk atau Kolmogorov Smirnov nilainya ≥ α (0,05). Berlaku juga 

sebaliknya, jika nilai sig (p value) pada uji Shapiro Wilk atau Kolmogorov 

Smirnov < α (0,05) maka disimpulkan bahwa sebaran data dikatakan tidak 

normal. Hal ini dikarenakan hipotesis pada uji sebaran data adalah sebagai 

berikut: H0 = sebaran data normal dan Ha/H1 = sebaran data tidak normal. 

Asumsi ketiga dari uji Anova adalah sampel hendaknya diambil secara 

random (acak), sehingga masing-masing data yang diamati bersifat bebas.  

Langkah Pengujian One Way Anova Menggunakan SPSS adalah  

1. Peneliti akan menguji apakah ada perbedaan rerata berat badan bayi 

antara ketiga kelompok sosial ekonomi (kaya, sedang, miskin).  

2. Susun hipotesis dari soal tersebut. Berdasarkan soal tersebut, maka 

dapat disusun hipotesis sebagai berikut: Ho: Tidak ada perbedaan rerata 

berat badan bayi pada ketiga kelompok sosial ekonomi (kaya, sedang, 

dan miskin). Ha/H1: setidaknya ada perbedaan rerata berat badan bayi 

pada ketiga kelompok sosial ekonomi (kaya, sedang, dan miskin). 

3. Cek asumsi sebaran data dan varian (dengan uji Levene). Klik Analyze, 

pilih Compare Means  

4. Tahapan untuk uji Anova Satu Arah di SPSS : Klik Analyze, klik 

Compare Means, pilih One-Way ANOVA. Pada uji One-Way 
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ANOVA, pada Dependent List: masukkan berat badan bayi, dan pada 

factor, masukkan data tingkat sosial ekonomi. Selanjutnya	klik	Options	
dan	klik	pilihan	sesuai	pilihan	sebagai	berikut:	 

   
Pilihan Descriptive dan Homogenity-of-Variance digunakan untuk 

melihat keseragaman pada perhitungan statistik. Selanjutnya, arahkan 

mouse untuk mengklik Post Hoc dan pilihan jenis Post Hoc. Klik Tukey 

dan Bonferroni perhatikan significance level yang digunakan. Pada 

gambar di atas tertulis 0,05 (menggambarkan dari nilai α sebesar 5%).  

 
Selanjutnya klik Continue dan klik OK. Tunggu Output. Selesai  

 

C. Aktivitas Praktikum 

1. Mahasiswa melakukan praktik pengolahan data dengan uji beda 2 mean 

independen dan dependen. 

2. Mahasiswa memahami dan mencatat langkah-langkah uji man whitney 

3. Mahasiswa praktik melalui aplikasi SPSS melakukan pengolahan data 

dengan uji man whitney. 

4. Mahasiswa memahami dan mencatat langkah-langkah uji wilcoxon. 

5. Mahasiswa praktik melalui aplikasi SPSS melakukan pengolahan data 

dengan uji Wilcoxon. 
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A. Tujuan Pembelajaran Praktikum 

Setelah mempelajari kegiatan praktikum 5 ini, diharapkan mahasiswa 

mampu melakukan pengolahan data dengan uji korelasi dengan langkah yang 

benar. 

 

B. Materi  

Uji korelasi untuk data numerik familiar dengan sebutan Uji Korelasi Pearson. 

Asumsi yang dibutuhkan oleh uji korelasi ini adalah sebaran data berdistribusi 

normal. Jika asumsi ini tidak terpenuhi, alternatifnya uji Rank Spearman. 

Tahapan Pengujian Korelasi Pearson dengan SPSS  

Buka SPSS, klik Analysis pilih Descriptive, dipilih Explore. Selanjutnya, 

masukkan berat badan dan kolesterol dalam Dependent List. Selanjutnya klik 

kotak Plots, pada kotak Boxplots centang pada Factor levels together. Pada 

kotak Descriptive centang bagian Stem-and-leaf dan Histogram, serta 

centang Normality plots with tests, dan terakhir klik Continue.  

 
Interpretasi dari output SPSS dari uji sebaran data  

1. Grafik Boxplot tidak simetris, tetapi tidak ada nilai outlier baik atas maupun 

bawah. Jadi, tidak berdistribusi normal.  

2. Grafik QQ plot menunjukkan tidak simetris dengan garis. Artinya, sebaran 

data tidak normal.  

 

 

KEGIATAN PRAKTIKUM 5 
UJI KORELASI / HUBUNGAN 

(PARAMETRIK) 
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3. Dari nilai kurtosis tidak berada di antara -1,96 sd +1,96.  

4. Nilai p value pada kolesterol (uji Shapiro Wilk) di bawah 0,05, maka 

distribusinya tidak normal. 

5. Jika sebaran data normal, uji korelasi Pearson tidak dapat dilakukan tetapi 

dengan uji alternatifnya, yaitu uji Rank Spearman.  
Cara	 melakukan	 uji	 korelasi	 Pearson	 dengan	 langkah	 sebagai	 berikut:	 klik	
Analyze	 kemudian	 klik	Correlate	dan	 selanjutnya	 klik	Bivariate.	 Pada	 kotak	
Variables	diisi	berat	badan	dan	kolesterol.	Kemudian	pada	kotak	Correlation	
Coefficients	dicentang	Pearson.	 Kotak	Test	 of	 Significance	dicentang	 bagian	
Two-tailed.	Kemudian	klik	Ok.	 

 
 

Interpretasi hasil output SPSS dari uji korelasi Pearson Sebelum menarik 

kesimpulan dari uji korelasi Pearson, kita harus tentukan terlebih dahulu terkait 

dengan hipotesis.  

Ho: tidak hubungan antara berat badan dengan kadar kolesterol 

Ha: hubungan antara berat badan dengan kadar kolesterol  

Sementara itu, cara menarik kesimpulan dari uji korelasi person ini adalah kita 

menyimpulkan Ho apabila nilai sig.(pvalue) lebih besar (>) dibandingkan 

dengan α. Sebaliknya kita dapat menyimpulkan Ha/H1 apabila nilai sig.(p 

value) lebih kecil sama (≤) dibandingkan dengan α. Berdasarkan hasil dari 

output SPSS di atas, nilai sig.(p value) sebesar 0,45 > α, yang artinya tidak ada 

hubungan antara berat badan dan kolesterol.  

Sementara itu, nilai koefisien korelasi (lihat nilai pada Pearson Correlation, 

biasanya diberi simbol r) dapat digunakan untuk mengetahui besar sumbangan 

variabel bebas terhadap variabel terikat, kekuatan hubungan, dan menentukan 

arah hubungan dari kedua variabel tersebut. Nilai r (Pearson Correlation), 

dikatakan koefisien korelasinya kuat apabila mendekati nilai +1/-1 (rentang 
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nilai -1 ≤ r ≤ +1). Jika nilai r mendekati angka nol (0), maka menunjukkan 

kekuatan hubungan yang lemah. Tabel 2 menunjukkan parameter kekuatan 

hubungan pada uji korelasi Pearson. Berdasarkan hasil output uji korelasi 

Pearson, nilai r = 0,07 (lemah).  

Rank Spearman Test (Uji Rank Spearman) 

Uji Rank Spearman ini adalah alternatif uji korelasi Pearson dikarenakan 

sebaran data tidak normal. Berikut langkah- langkah untuk melakukan uji 

sebagai berikut:  

1. Klik Analyze, kemudian klik Correlate, dan kemudian klik Bivariate.  

 
 

Interpretasi hasil : Lihat nilai p value = 0,601, jika dibandingkan dengan nilai 

α (5%), maka dapat disimpulkan bahwa nilai sig.> α =0,05, yang maknanya 

tidak ada hubungan antara berat badan dengan kolesterol.  

 

C. Aktivitas Praktikum  

1. Mahasiswa melakukan praktik pengolahan data dengan uji korelasi 

2. Mahasiswa memahami dan mencatat langkah-langkah uji korelasi 

3. Mahasiswa praktik melalui aplikasi SPSS melakukan pengolahan data 

dengan uji korelasi pearson. 

4. Mahasiswa memahami dan mencatat langkah-langkah uji korelasi pearson. 

5. Mahasiswa praktik melalui aplikasi SPSS melakukan pengolahan data 

dengan uji Rank Spearman. 
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A. Tujuan Pembelajaran Praktikum 

Setelah mempelajari kegiatan praktikum 6 ini, diharapkan mahasiswa 

mampu melakukan pengolahan data dengan uji korelasi dengan langkah yang 

benar. 

 

B. Materi  

Uji Chi Square atau ada yang menyebutnya dengan uji Kai Kuadrat atau 

biasanya juga diberi simbol !2 (chi) yang berasal dari bahasa Yunani sehingga 

pada uji Chi Square ini menggunakan distribusi Chi Square (Wassertheil-

Smoller, 2015). Berikut ini ada beberapa macam jenis uji Chi Square.  

1. Test of goodness of fit  

2. Tes Independensi (Test of independence)  

3. Test of homogeneity  

Uji sebaran data tidak diperlukan dalam uji Chi Square. Hal-hal yang 

perlu diperhatikan pada uji Chi Square adalah nilai-nilai frekuensi observasi 

(observed frequencies) dan nilai-nilai frekuensi harapan (expected frequencies). 

Kedua nilai tersebut akan menentukan jenis uji Chi Square yang akan digunakan. 

Uji Goodness of Fit adalah salah satu uji Chi Square, yang bertujuan 

untuk mengetahui apakah sebuah distribusi data observasi (sampel) mengikuti 

data distribusi teoretisnya. Langkah-langkah yang dilakukan untuk melakukan 

uji Goodness of Fit dengan menggunakan SPSS sebagai berikut:  

1. Buka SPSS, klik Analyze kemudian pilih Nonparametric, selanjutnya pilih 

Chi Square. Pada kotak Test Variable List masukkan rokok, kotak 

Expected Range dicentang bagian Get from data, dan bagian Expected 

Value dicentang bagian All categories equal.  

 

 

 

KEGIATAN PRAKTIKUM 6 
UJI KORELASI /HUBUNGAN 

(NONPARAMETRIK) 
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2. Interpretasi hasil uji Goodness of Fit 

Sebelum membuat sebuah kesimpulan, maka dibuat hipotesis terlebih dahulu.  

Ho: distribusi frekuensi observasi mengikuti distribusi harapannya 

Ha: distribusi frekuensi observasi tidak mengikuti distribusi harapannya  

Dasar pengambilan keputusan sebagai berikut: Kita menyimpulkan Ho 

apabila nilai sig. (p value) ≥ 0,05, yang artinya distribusi frekuensi observasi 

sesuai dengan frekuensi harapannya. Sebaliknya, kita menyimpulkan Ha/H1 

apabila nilai sig. (p value) < α (0,05), yang artinya distribusi frekuensi 

observasi tidak sesuai dengan distribusi frekuensi harapannya.  

C. Aktivitas Praktikum 

1. Mahasiswa melakukan praktik pengolahan data dengan uji korelasi 

2. Mahasiswa memahami dan mencatat langkah-langkah uji korelasi 

3. Mahasiswa praktik melalui aplikasi SPSS melakukan pengolahan data 

dengan uji chi square. 

4. Mahasiswa memahami dan mencatat langkah-langkah uji chi square. 

5. Mahasiswa praktik melalui aplikasi SPSS melakukan pengolahan data 

dengan uji chi square. 
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A. Tujuan Pembelajaran Praktikum 

Setelah mempelajari kegiatan praktikum 7 ini, diharapkan mahasiswa 

mampu melakukan pengolahan data dengan uji korelasi dengan langkah yang 

benar. 

 

B. Materi  

Regresi Logistik adalah suatu metode analisis statistika yang digunakan 

untuk mendeskripsikan hubungan antara variabel terikat yang memiliki dua 

kategori atau lebih dengan satu atau lebih peubah bebas berskala kategori atau 

kontinu. Uji Regresi Logistik dilakukan untuk memeriksa peranan variabel 

prediktor terhadap variabel respons secara serentak atau secara keseluruhan.  

Langkah Uji Regresi Logistik sebagai berikut (Hidayat, 2015):  

1. Langsung saja buka aplikasi SPSS dan masukkan data  

 
2. Pilih tab Variable View 

 
3. Klik Values X1 dan isikan berikut: 

 

 

 

KEGIATAN PRAKTIKUM 7 
UJI  REGRESI LOGISTIK 

KESEHATAN 
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4. Klik Values X2 dan isikan berikut: 

 
5. Klik Values Y dan isikan berikut: 

 

6. Kemudian pada menu, klikAnalyze -> Regression -> Binary Logistic. 

Kemudian masukkan variabel terikat ke kotakDependentdan masukkan 

semua variabel bebas ke kotak Covariates. 

 
7. Tekan tombol Save lalu centang Probabilities, Group membership, 

Unstandardized dan Studentized kemudian klik Continue.  
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8. Tekan tombol Options lalu centang Classification plots, Hosmer-

lemeshow goodness-of-fit, Casewise listing residuals dan pilih Outliers 

outside dan isi dengan angka 2, Correlation of estimates, Iteration 

history, CI for exp(B) dan isi dengan 95.  

 
9. Terkait nilai Maximum iteration tetap membiarkan sebesar 20 dan nilai 

Classification cutoff tetap 0.5. Nilai ini disebut dengan the cut value atau 

prior probability, yaitu peluang suatu observasi untuk masuk ke dalam 

salah satu kelompok sebelum karakteristik variabel penjelasnya diketahui. 

Jika tidak mempunyai informasi tambahan tentang data, kita langsung bisa 

menggunakan nilai default, yaitu 0,5. Apabila tidak ada penelitian 

sebelumnya, dapat digunakan Classification cutoff sebesar 0,5. Namun, 

jika terdapat penelitian lain yang telah meneliti judul yang sama, bisa 

dinaikkan/diturunkan Classification cutoff sesuai hasil penelitian.  

10. Langkah selanjutnya pada tampilan jendela utama, klik OK dan lihat 

Output/Hasil Uji Regresi Logistik  

C. Aktivitas Praktikum  

1. Mahasiswa melakukan praktik pengolahan data dengan uji regresi logistik. 

2. Mahasiswa memahami dan mencatat langkah-langkah uji regresi logistik. 

3. Mahasiswa praktik melalui aplikasi SPSS melakukan pengolahan data 

dengan uji regresi logistik. 

4. Mahasiswa memahami dan mencatat langkah-langkah uji regresi logistik. 

5. Mahasiswa praktik melalui aplikasi SPSS melakukan pengolahan data 

dengan uji regresi logistik. 
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Lampiran 1. Daftar Mahasiswa  

 

DAFTAR MAHASISWA SEMESTER IV 
PROGRAM STUDI S-1 ADMINISTRASI RUMAH SAKIT T.A. 2023/2024 

 

NO NIM NAMA MAHASISWA 

1 224100014 Dhyah Ayu Aprilia Putri H 

2 224100016 Resti Callista Bary 

3 224100017 Safira Izzaliatul Isha 

4 224100018 Rindi Zunita Altinia 

5 224100020 Eleonora Dewi Pereira Fernandez 

6 224100023 Joy Armando Adnan 

7 224100024 Vinsensius Caesarrando P 



 

Lampiran 2. Jadwal Praktikum 	
JADWAL	TENTATIF	PBM	SEMESTER	IV	(GENAP)	

PRODI	SARJANA	ADMINISTRASI	RUMAH	SAKIT	TA	2023/2024	
	
Mata	Kuliah	 	 :	Biostatistik	Kesehatan	(3	SKS	=	2T	1P)	
PRAKTIKUM		 :	1	SKS	
	

PERT	
KE-	 MG	 HARI	 TANGGAL	 JAM	 MATERI	 DARING/	

LURING	 DOSEN	

1	 6	 Rabu	 3-Apr-2024	 07.00-08.40	 Pendalaman	pengolahan	data	melalui	SPSS		(1)	 LURING	 Tutik	Wahyuningsih,	SKM.,	MPH	

1	 	 	 	 	 Pendalaman	pengolahan	data	melalui	SPSS	(2)	 LURING	 Tutik	Wahyuningsih,	SKM.,	MPH	

2	 10	 Rabu	 15-Mei-2024	 07.00-08.40	 pengolahan	data	secara	deskriptif,	bivariat	dan	
multivariat	(1)		 LURING	 Tutik	Wahyuningsih,	SKM.,	MPH	

2	 	 	 	 	 pengolahan	data	secara	deskriptif,	bivariat	dan	
multivariat	(2)	 LURING	 Tutik	Wahyuningsih,	SKM.,	MPH	

3	 11	 Rabu	 22-Mei-2024	 07.00-08.40	 Uji	beda	2	mean	independen	dan	dependen	
(nonparametrik)	(1)	 LURING	 Tutik	Wahyuningsih,	SKM.,	MPH	

3	 	 	 	 	 Uji	beda	2	mean	independen	dan	dependen	
(nonparametrik	(2)	 LURING	 Tutik	Wahyuningsih,	SKM.,	MPH	

4	 12	 Rabu	 29-Mei-2024	 07.00-08.40	 Uji	beda		>2	mean	(parametrik)	(1)	 LURING	 Tutik	Wahyuningsih,	SKM.,	MPH	

4	 	 	 	 	 Uji	beda		>2	mean	(parametrik)	(2)	 LURING	 Tutik	Wahyuningsih,	SKM.,	MPH	

5	 13	 Rabu	 5-Juni-2024	 07.00-08.40	 Uji	korelasi/asosiasi/hubungan	(parametrik)	(1)	 LURING	 Tutik	Wahyuningsih,	SKM.,	MPH	

5	 	 	 	 	 Uji	korelasi/asosiasi/hubungan	(parametrik)	(2)	 LURING	 Tutik	Wahyuningsih,	SKM.,	MPH	

6	 14	 Rabu	 12-Juni-2024	 07.00-08.40	 Uji	korelasi/asosiasi/hubungan	(nonparametrik)	
(1)	 LURING	 Tutik	Wahyuningsih,	SKM.,	MPH	

6	 	 	 	 	 Uji	korelasi/asosiasi/hubungan	(nonparametrik)	
(2)	 LURING	 Tutik	Wahyuningsih,	SKM.,	MPH	

7	 15	 Rabu	 19-Juni-2024	 07.00-08.40	 Uji	regresi	logistik	kesehatan	(1)	 LURING	 Tutik	Wahyuningsih,	SKM.,	MPH	

7	 	 	 26-Juni-2024	 07.00-08.40	 Uji	regresi	logistik	kesehatan	(2)	 LURING	 Tutik	Wahyuningsih,	SKM.,	MPH	
	



 

Lampiran 3. Format Penilaian 
 
 
A. Format Penilaian Laporan Praktikum 

No. Aspek yang dinilai Skor 
Maksimal 

Skor yang 
diperoleh 

1.  Sistematika laporan 25  

2.  Kelengkapan laporan 25  

3.  Ketepatan dalam tinjauan teori 25  

4.  Ketepatan Format Penulisan 
Laporan 

25  

Total Skor 100  
 
 
B. Format Penilaian Praktik  

No. Aspek yang Dinilai Skor 
Maksimal 

Skor yang 
Diperoleh 

1.  Menguasai teori 
 

20  

2.  Paham dengan Langkah-langkah 20  

3.  Mampu menentukan jenis uji 
 

20  

4.  Mampu melakukan pengolahan data 
 

20  

5.  Mampu melakukan uji dengan SPSS 20  

Total Skor 100  

 
 


